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Warranty 
Global Water Instrumentation, Inc. warrants that its products are free from defects in material and 
workmanship under normal use and service for a period of one year from date of shipment from 
the factory.  Global Water’s obligations under this warranty are limited to, at Global Water’s op-
tion: (I) replacing or (II) repairing; any products determined to be defective.  In no case shall 
Global Water’s liability exceed the products original purchase price.  This warranty does not apply 
to any equipment that has been repaired or altered, except by Global Water Instrumentation, Inc., 
or which has been subject to misuse, negligence or accident.  It is expressly agreed that this war-
ranty will be in lieu of all warranties of fitness and in lieu of the warranty of merchantability. 
The warranty begins on the date of your invoice. 

Warranty 

Requirements 
• Windows 95, 98, ME, NT, 2000 or XP* 
• 486DX 66MHz, 16MB RAM (Windows 95 base machine; later operating systems may require 

higher specifications) 
• Available COM port 

*Windows® 95, 98, ME, NT, 2000 & XP are trademarks of the Microsoft Corporation 

Terminology 
In order to better understand this product manual, please be aware of the following terminology 
and formatting standards. 

Bolded terms (i.e. bold) indicate either a keyboard key, a word or icon that appears on your com-
puter monitor screen or a phrase to be emphasized.  Context will dictate which is indicated. 
Since it is assumed that users of this manual are familiar with mouse usage, many mouse opera-
tions are implied.  The term “click” or “clicking” means to press and release the left mouse button.  
Similarly, “double-click” means to press and release the left mouse button twice in quick succes-
sion.  For example, the phrase “Click the start button” should be interpreted as “Move the mouse 
pointer to the task bar and click the start button.”  If any other mouse button is used in an opera-
tion, it will be specified in the documentation. 
The term “select” means to move the mouse pointer over the indicated target.  For example the 
phrase “Select Toolbars from the View menu” means to move the mouse pointer over View, click 
View and then move the mouse pointer over Toolbars.  This action provides access to the Tool-
bars menu.  “Select” is normally used when the mouseover action will cause additional menus to 
display. 

Contact Information 
Global Water Instrumentation, Inc. 
11390 Amalgam Way 
Gold River, CA  95670 

Toll Free: 1(800)876-1172 
Local:  1(916)638-3429 
Fax:  1(916)638-3270 
E-mail: globalw@globalw.com 
Web:  www.globalw.com  
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The → symbol is used with submenu operations where the user should click the first and last 
items in the string separated by →.  For example, the phrase “Click on File → New → Folder” 
means click on File, select New and click on Folder. 
When the documentation directs you to exit a program or window, you can generally do so by 
clicking the x graphic in the upper right-hand corner or by clicking File → Exit. 

x graphic 
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1 Introduction 

The GL400 Datalogger 
Congratulations on your purchase of the Global Water GL400 Datalogger.  This instrument has been quality 
tested and approved to provide accurate and reliable measurements for a variety of sensors.  We are confi-
dent you will find the GL400 to be a valuable asset for your applications.  Should you require assistance, 
our technical staff will be happy to help. 

The GL400 is the latest addition to our line of rugged remote monitoring instrumentation and comes in two 
varieties: the 8-channel (GL400-7-1) and 2-channel (GL400-1-1) loggers.  The 8-channel logger features 7-
analog and 1-pulse channels for data recording, while the 2-channel features 1-analog and 1-pulse.  The 
Global Logger* software package operates on the user-friendly operating systems Microsoft Windows® 95, 
98, ME, NT, 2000 and XP**.  

Remote monitoring sensors are connected to the GL400's internal terminal junctions.  Types of sensors that 
are typically used include Dissolved Oxygen, pH, Conductivity, Turbidity, Temperature, ORP, Water 
Level, Wind Speed, Wind Direction, Humidity, Barometric Pressure, Solar Radiation and Rain Gauges.  
Contact us for unique, special and custom modifications to meet the requirements of your application.  

The GL400 Datalogger is designed to accept any 4-20 mA sensors.  Twisted pair 2-wire and 3-wire sensors 
can be quickly connected to the logger's terminal strip providing them with switched power and connecting 
them to the GL400’s data processes.  

The GL400's rugged, lockable and weather-resistant enclosure can easily be hidden, bolted to a post or se-
cured inside an additional container for added protection from the elements, animals, or vandals. 

Introduction 

*  Copyright © Global Water Instrumentation, Inc. 2001 
**Windows® 95, 98, ME, NT, 2000 & XP are trademarks of the Microsoft Corporation 

Features 
GL400-7-1 GL400-1-1 
Data 
• Windows based Global Logger* software 
• Tabular display/printout 
• Data in standard spreadsheet format 
• Communication cable included (RS232C) 
Logger 
• 7-analog 1-pulse channels 
• Low power internal battery with charger 
• 8,000 data logs per channel 
• 12-bit or 1/4,000 resolution 
• UV protected PVC weather-resistant enclosure 

Data 
• Windows based Global Logger* software 
• Tabular display/printout 
• Data in standard spreadsheet format 
• Communication cable included (RS232C) 
Logger 
• 1-analog 1-pulse channels 
• Low power internal battery with charger 
• 19,500 data logs per channel 
• 12-bit or 1/4,000 resolution 
• UV protected PVC weather-resistant enclosure 
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Checklist 
Your GL400 was carefully inspected and certified by our Quality Assurance Team before shipping.  If any  
damage has occurred during shipping, please notify Global Water Instrumentation, Inc. and file a claim 
with the carrier involved.  Use the checklist to ensure that you have received everything needed to operate 
the GL400.  Note, there are two different varieties of dataloggers, the GL400-7-1 and GL400-1-1.  Use the 
checklist appropriate to your model number. 

Chapter 1 

Package Contents for GL400-7-1 

• GL400-7-1 (8-Channel Datalogger) 
• User Manual 
• Communication Cable (RS232C COM Cable) 
• Global Logger Software (3 1/2” Floppy Diskette) 

Communication Cable 

Global Logger* Software 

User Manual 

Datalogger 

*Copyright © Global Water Instrumentation, Inc. 2001 
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Package Contents for GL400-1-1 

• GL400-1-1 (2-Channel Datalogger) 
• User Manual 
• Communication Cable (RS232C COM Cable) 
• Global Logger Software (3 1/2” Floppy Diskette) 

Communication Cable 

Global Logger* Software 

User Manual 

Datalogger 

Introduction 

*Copyright © Global Water Instrumentation, Inc. 2001 
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Getting to Know the GL400 

The COM port can connect to a PC se-
rial port using the included Communica-
tion Cable. 

COM port 

Access the included 12V, 2 AH lead acid gell 
cell directly from inside enclosure. 

Chapter 1 

The GL400 is enclosed in a UV protected 
PVC weather-resistant enclosure. 
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Each end of the Communication Cable is identical.  Connect one DB-9 fe-
male connector to your PC and the other to your Datalogger. 

GL400-7-1 GL400-1-1 

Introduction 

Connect sensors to the GL400 by 
threading sensor cables through 
the enclosure’s strain reliefs (8 on 
the GL400-7-1 and 2 on the 
GL400-1-1) and attaching cable 
wires to the channel terminals. 

attach cable wires 
to terminals 
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2 Setup 

Installing the GL400 

To verify your system time in Windows, click Start → Set-
tings → Control Panel from the task bar. 

Double-click the Date/Time icon. 

Before you install the software, check the accuracy of the time and date on your computer.  The GL400 will 
be programmed with this information. 

System Time Check 

Chapter 2 
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 Setup 

Verify that your system is set to the cor-
rect time.  If not, make the necessary 
changes, click the Apply button and then 
the OK button.  Exit the control panel. 

Double-click the My Computer icon on your desktop. 

Double-click the floppy icon (normally listed as 3 ½ floppy (A:)). 

Insert the 3 1/2” floppy diskette labeled “Global Logger Software Version x.xx” (where x.xx is a version 
number such as 1.38) into your computer’s floppy disk drive.  Normally, the floppy is configured as a sys-
tem’s “A” drive. 

Global Logger Software Installation 
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Click on the file Global Logger.exe.  

Click Edit → Copy from the menu bar. 

Chapter 2 
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If the directory Global Logger is not 
listed, click File → New → Folder from 
the menu bar. 

Setup 

Save the file to a directory of your choosing.  Note, it should be a location you will easily remember.  To 
save to the directory Global Logger located on your main “C” hard drive (although “C” is normally the 
main system drive, the designation can vary from system to system), start by clicking the down carrot of the 
address field.  Click on the Local Disk (C:) icon or appropriate main system drive designation. 

down carrot 

The directory New Folder should now be created and automatically se-
lected for typeover.  Type Global Logger and press the enter key. 
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Double-click on the new 
Global Logger directory. 

Click Edit → Paste from the menu bar. 

A Copying… dialog box should now display.  
Wait for the copy process to complete. 

Chapter 2 
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To create a desktop shortcut, right-click the Global Logger.exe file you previously saved, select Send To 
and click on Desktop (create shortcut). 

You can now access your Global Logger* software directly from the desktop. 

Hardware Installation 

General Installation Tips 

• The datalogger is not waterproof.  It is water-resistant.  This means that condensation, which can 
build up inside the enclosure during humid conditions, should not affect the performance of the GL400.  
However, if the datalogger is submerged in water, it will corrode the electronics and cause it to stop 
working properly.  Please ensure that the datalogger will be clear from flooding and out of direct rain-
fall. 

• The accuracy of the sensor readings can be affected by such adverse conditions as overpressure, lighten-
ing strikes, improper care/handling, and physical damage or abuse. 

• Do not install GL400 sensors in applications that contain solvents.  Over time, many solvents can 
deteriorate the cable and the sensing elements. 

• Install your GL400 so that it is easily accessible for calibration purposes.  You may need to remove and 
reinstall it in the future, so plan ahead! 

*Copyright © Global Water Instrumentation, Inc. 2001 

Setup 
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Sensor Installation 

You can connect 2-wire or 3-wire sensors to the 
GL400.  Before connecting a sensor, first discon-
nect the battery spade lugs from terminals. 

red (+) terminal black (-) terminal 

Note, the following instructions and screenshots specifically refer to the GL400-7-1.  If you have purchased 
the GL400-1-1, you will only be able to utilize analog channel 1 (C1) and the pulse channel (Pulse). 

You can connect analog sensors to chan-
nels 1 – 7 (C1 – C7) on the terminal strip 
and a pulse sensor to the Pulse channel.  
Note, you can connect an external power 
source to the Ext. terminals, located be-
low the internal battery (Batt.) terminals. 

battery terminals analog channels 1 – 7 pulse channel 

Chapter 2 

To connect a sensor thread sensor cable through an enclosure strain relief, and attach cable wires to the 
channel terminals.  Before inserting wires into terminals you may need to loosen terminal screws. 

For 2-wire analog sensors, insert black wire into the S (signal) terminal and tighten until secure.  Next, in-
sert red wire into the + (power) terminal and tighten until secure. 

For 3-wire analog sensors, insert black wire into the – (ground) terminal and tighten until secure.  Next, in-
sert white wire into the S (signal) terminal and tighten until secure.  Finally, insert red wire into the + 
(power) terminal and tighten until secure. 

2-wire: 
terminals +/S 

3-wire: 
terminals +/S/- 
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Connect the battery’s blue spade lug to 
the black terminal followed by the red 
spade lug to the red terminal. 

step 1: connect blue spade 
lug to black terminal 

step 2: connect red 
spade lug to red terminal 

Your sensor is now connected to the logger and is accessible* through the Global Logger** software pack-
age. 

*  See Global Logger Startup, page 18. 
**Copyright © Global Water Instrumentation, Inc. 2001 

For pulse sensors polarity is not an issue, so red and black wires may be inserted in either P terminals.  In-
sert black/red wire into one P terminal and tighten until secure.  Insert the black/red wire into the other P 
terminal and tighten until secure.  There is no pulse signal terminal. 

pulse: P terminals 

Setup 
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3 Using Global Logger Software 

Chapter 3 

Hardware Connection 
Connect the DB-9 female connector of the included communication cable (RS232C) to the COM 1 serial 
port on your computer.  If COM 1 is being used, either disconnect and/or disable the device on COM 1 or 
connect to COM 2*. 

Double-click the Global Logger** icon on your desktop if you created a desktop shortcut during 
software setup.  Otherwise, access the directory in which your Global Logger.exe file is located 
and double-click on the file.  If you have not installed the Global Logger software or if you want 
to create a desktop icon, see Global Logger Software Installation***.  Note that the screen-
shots in Chapter 3: Using Global Logger Software represent those of an eight channel logger 
(GL400-7-1).  If you own a different model such as the GL400-1-1, Global Logger will display 
differently. 

Global Logger Startup 

Connect the DB-9 male connector 
of the communication cable 
(RS232C) to your GL400 COM 
port. 

DB-9 connector 

*    See Comm Failure, page 32. 
**  Copyright © Global Water Instrumentation, Inc. 2001 
***See Global Logger Software Installation, pages 11 – 15 
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 Using Global Logger Software 

*Copyright © Global Water Instrumentation, Inc. 2001 

The Global Logger* main window will display data in the following fields: Logger Name, Date/Time, Re-
cording Interval and Recordings in Memory. 

Access the Global Logger functions Sample Continuously, Get Settings, Get History Data, Clear Mem-
ory, Synchronize Time and Setup through the main menu check box and buttons.  All Global Logger 
functions can also be accessed through Action on the menu bar. 
The bar graphs indicate zero to full-scale range of sensor for the eight analog channels of the datalogger.  
For example, the channel 4 graph in the following screen shot displays a 120 foot sensor with a reading of 
23.3 feet.  This data indicates that the sensor is currently at a depth of 23.3 feet.  Sensors are calibrated to a 
variety of unit specifications (i.e. meters, percent, etc.), so your bar graph readings may differ slightly.  
Note that the GL400 terminal strip can only accommodate seven analog sensors, so one channel will not be 
used. 

The pulse unit field (currently displaying Inches) at the top right of the window indicates the current single 
pulse channel reading. 

zero to full-scale graph 

Global Logger 
functions 

pulse channel reading 
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Get Settings 
To refresh information in the Global Logger* main window, click the Get Settings button.  This action will 
update the Logger Name, Date/Time, Recording Interval and Recordings in Memory fields. 

*Copyright © Global Water Instrumentation, Inc. 2001 

Global Logger Functions 

Sample Continuously/Real-Time Values 
To display real-time values each second, select the Sample Continuously checkbox.  Readings will display 
below each zero-to-full-scale-range graph.  To stop readings, unselect checkbox.  Note, that real-time data 
is not recorded; therefore, you cannot retrieve it from GL400 memory. 

current reading 

past readings 

zero-to-full-scale-
range graph 

Chapter 3 
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Get History Data 

To retrieve logged data from memory, click the Get History Data button.  The speed of your upload will 
depend on the number of data points recorded (more recordings equals longer upload time).  To minimize 
long upload times, clear memory* after backing it up to disk**. 

*  See Clear Memory, pages 23 
**See Get History Data, pages 22 

A Historical Data Viewer window will display.  This window lists each data point for every channel by 
Date / Time and reading value.  Channel 1 readings are displayed in the column immediately to the right of 
the Date / Time column and additional channels consecutively to the right of channel 1.  If there are more 
data points in memory than will fit in the data view window, use the vertical scroll bar to scroll through the 
list of readings.  To view the pulse channel column, scroll to the right using the horizontal scroll bar. 

readings listed by Date / Time and 
reading value (in this case Feet) 

use scroll bar to 
scroll through list 

channel 1 

scroll right to view additional 
channels and/or pulse channel 

Using Global Logger Software 
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If you want to save current readings, click the Save to File button. 

A Save As window will display.  If you 
want to save your file to a directory other 
than the one displayed, click the down 
carrot of the Save in: field and click on 
the device (i.e. hard disk drive, floppy 
disk drive, etc.) you want to save the file 
to. 

down carrot 

Click OK to exit the Historical Data View window. 

*Windows® Excel is a trademark of the Microsoft Corporation 

Double-click the directory or subdirec-
tory you want to save to.  If you want to 
change the file name click anywhere in 
the File name: field and type the desired 
name.  However, do not change the .csv 
extension.  This extension ensures the 
file will be recognized as a comma sepa-
rated value (*.CSV) file.  You can open 
CSV files in spreadsheet programs such 
as Microsoft Excel*.  Click Save to save 
the file. 

change name in 
file name field 

To remove duplicate readings, click the Pack button.  Note, this operation will not remove the initial dupli-
cate reading on each channel.  For this feature to work, all channels must have consecutive duplicate read-
ings.  Since the pack function does not change the readings stored in memory, you will need to Save to File 
to preserve the pack operation.  If you exit and then reenter the Historical Data Viewer window, all read-
ings (including zero readings) stored in memory will display regardless of any prior pack operation. 

Chapter 3 
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Clear Memory 

To clear your GL400’s memory of readings click the Clear Memory button. 

A confirmation dialog box will display.  Click Yes to clear history or 
No to keep readings. 

If you click Yes, a Standby graphic will display in the middle of 
your monitor screen while the memory is purged. 

Synchronize Time 
To synchronize your GL400’s internal clock to your computer’s clock*, click the Synchronize Time but-

A Standby graphic will display in the middle of your monitor 
screen while synchronizing. 

Setup 
Note that your datalogger has come completely setup from our factory.  It has been calibrated and tested for 
optimal accuracy and performance with any sensors you have ordered along with your datalogger.  If you 
choose to recalibrate your sensors or calibrate additional sensors, use the following procedures. 

*See System Time Check, pages 10 – 11 

Using Global Logger Software 
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Datalogger Name and Sensor Warmup Time 

To begin calibration and/or to change time interval settings, click the Setup button.  A Global Water 
Setup window will display. 

If you want to change the datalogger name, click in the Name field and type in a new name. 

In order to supply connected sensors with adequate power for accurate data measurments, set the Sensor 
Warmup Time field to the specification indicated in your sensor manual.  Note that this field should reflect 
the sensor specification with the longest warm-up time.  This setting dictates the length of time power is 
applied to the attached sensors before the datalogger takes a reading. 

For example, you set Global Logger* to a sensor warm-up time of 3 seconds, and to record readings every 
20 minutes at fixed intervals.  If the process begins at 12:02:00, power will be applied to attached sensors 
immediately and readings taken at 12:02:03.  At 12:22:00, power will again be applied to the attached sen-
sors, and the datalogger will take readings at 12:22:03.  Note that if the recording interval fields are less 
than or equal to the Sensor Warmup Time field, any attached sensors are powered continuously. 

To change warm-up time, click in the Sensor Warmup Time field and enter the desired time (0 –15 sec-
onds).  You may also click the up/down arrows to the right of the text field to increase or decrease the value 
by 1. 

recording interval 
fields 

*Copyright © Global Water Instrumentation, Inc. 2001 

Chapter 3 
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If performing a lab calibration, insert the sensor into the appropriate calibration meter and set to full scale 
range of the sensor.  If performing an environmental calibration, insert sensor into its targeted environment 
at conditions of at least 10% of full scale range.  For example a 120’ water level sensor should be calibrated 
at a water depth of at least 12’.  Calibrating at greater percentages (up to 100%) provides greater accuracy. 

Enter the maximum unit range of the 
sensor (120 for a 120’ level sensor in 
this example) in the highest value text 
field and click the Next button. 

Change the Sensor Type or EU (engineering units) field to the unit type you are calibrating to (i.e. meters, 
feet, etc.) by clicking in the field and typing the unit name.  Note that the Sensor Type or EU field is only a 
text label.  Actual readings are determined by the following calibration steps. 

In case you make a mistake during the calibration process, write down the existing values in the High Raw 
and Low Raw fields before continuing (in this case 64435 and 12704).  Click the Calibrate button. 

Analog Channel Calibration 

Using Global Logger Software 
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For both environmental and lab calibrations, 
wait at least five seconds for the sensor to 
adjust to current sensing levels.  Click the 
Next button. 

Enter 0 in the lowest value text field and 
click the Next button. 

For lab calibrations, release the sensor from calibration meter.  For environmental calibrations, take sensor 
out of targeted environment.   

For both environmental and lab calibrations, 
wait at least five seconds for the sensor to 
adjust to 0 sensing levels.  Click the Finish 
button. 

*See Appendix B: Worksheets, pages 36 

Note, that if performing an envi-
ronmental calibration at a frac-
tion of total sensor range, the 
bar graphs in the main Global 
Logger window will interpret 
full scale range at maximum  
calibration readings instead of 
actual total sensor range.  All 
other logger operations will per-
form correctly.  To revise cali-
bration settings so that the 
graphs will function correctly, 
follow the worksheet Calibrat-
ing the Bar Graph to Higher 
or Lower Range in Appendix 
B*. 

Chapter 3 
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 Using Global Logger Software 

Pulse Channel Calibration 

To change pulse channel settings, refer to the Pulse Input fields in the Global Logger Setup window.  The 
pulse channel records a predetermined value each time the sensor detects a pulse signal.  This feature is of-
ten used to track rainfall levels. 

To change the displayed unit type (i.e. meters, feet, etc.), tap the Sensor Name or EU (engineering units) 
field and enter the unit type you are calibrating to.  Note that the Sensor Name or EU field only serves as a 
text label. 

To set the recorded value for a single pulse reading, tap the Value for Single Pulse field and enter the de-
sired predetermined value. 

To set the number of decimal place values to display, tap the Decimal Places field and enter the number of 
decimal places (0 – 6), or click the up/down arrows to the right of the text field to increase or decrease the 
value by 1.  After changing settings, click the OK button.  To cancel changes, click Cancel. 

Verify that High EU and Low EU fields reflect desired unit readings.  Also, verify that the High Raw field 
reflects a range of 60,000 – 65,000 and that the Low Raw field reflects a range of 10,000 – 15,000. 

Adjust the Decimal Places field according to the accuracy percentage rating.  The number of decimal 
places should not exceed the accuracy of the sensor.  After calibrating, click the OK button.  To cancel 
changes, click Cancel. 
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Select the interval type by clicking the down carrot of the Sample field.  To repeatedly record values at a 
specified interval, click for fixed interval. 

down carrot 

Recording Interval and Memory Management 

*See Battery, page 31 

Set the recording interval digit, by clicking in the every text field, and typing the desired number.  You may 
also click the up/down arrows to the right of the text field to increase or decrease the value by 1. 

up/down arrows 

Set the recording interval time unit, by clicking the down carrot of the time unit field (not labeled) and 
clicking Seconds, Minutes, Hours or Days. 

Chapter 3 

Note, that if you choose to record at fixed intervals, memory will fill up according to the following product-
specific charts.  Refer to battery maintenance chart for battery life to available memory comparisons*. 

GL400-7-1 
Recording Interval Time 

1 second 2 hours, 20 minutes 

1 minute 5 days, 20 hours 

5 minutes 29 days 

15 minutes 87 days 

30 minutes 175 days 

1 hour 350 days 

GL400-1-1 
Recording Interval Time 

1 second 5 hours, 31 minutes 

1 minute 13 days 

5 minutes 68 days 

15 minutes 206 days 

30 minutes 413 days, 30 hours 

1 hour 827 days 
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To record values according to a logarithmic curve, click 
for logarithmic interval.  See chart for timeline speci-
fications. 

Time Frame Readings per time 
unit 

Expected total readings 
during Time Frame 

0-19 seconds As fast as possible 1000 

20-59 seconds 1 per 1 second 40 

60-599 seconds 1 per 12 seconds 45 

10-99 minutes 1 per 2 minutes 45 

100-999 minutes 1 per 200 minutes 45 

1000-9999 min-
utes 

1 per 1440 minutes 45 

To take readings upon exceeding a specified unit range, click upon exception.  This setting sets the logger 
to record a single reading after detecting a ± variance from the previously recorded exception reading.  
Click the long bar appearing at the bottom of the Global Logger Setup menu  

The bar should change to reflect the latest exception setting.  The setting in these screenshot examples sets 
the logger to record a single reading after reading changes (rises or falls) by 10.2 feet from the previous ex-
ception. 

Click and hold toggle slider with 
left mouse button (i.e. do not click 
and release).  Move slider left or 
right to select desired exception 
range, and release mouse button.  
Click OK to preserve selection or 
Cancel to revert to the previous 
setting. 

toggle slider 

The Wrap records at end of storage checkbox dictates whether or not the logger continues to record read-
ings after its memory is filled.  To overwrite readings in synchronous order (earliest readings are overwrit-
ten first) after memory is filled, click the checkbox.  To preserve readings and stop recording after memory 
is filled, leave box unchecked. 

Using Global Logger Software 
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 Chapter 3 

After calibrating and/or changing interval recording settings, click the OK button.  To cancel changes, click 
Cancel. 
You may also manually change GL400 settings directly using a terminal program*. 

*See Appendix C: Terminal Programming, page 38 
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4 Maintenance 

Battery 
Global Water recommends that the battery voltage be physically checked based on your recording interval*.  
Refer to the following table. 

Note, that the GL400 uses 160µA while “sleeping” and 10mA plus the signal current while taking readings.  
This table is based on the worst-case scenario where all sensors are providing the maximum signal of 
20mA. 

Temperature can also affect battery life.  A GL400 in an environment that has a sustained temperature of 
23° C will run 5% longer than a unit that has a sustained temperature of 0° C. 

*See Recording Interval and Memory Management, pages 28 – 30 

Checking the battery requires the GL400 en-
closure be opened. remove connectors 

Test the battery with a voltage meter.  The datalogger will not work reliably if the battery voltage is below 
10V.  If the battery is allowed to drain below 9V it may not charge back to 12V when the charger is applied.  
The battery can be recharged using the included transformer, see Appendix D for charging instructions.  If 
the battery needs to be replaced, use a 12V, 2 AH lead acid gel cell for reliable service.  Insert the battery 
into the battery slot and reattach the battery connectors to terminals (blue connector to black terminal first 
and red connector to red terminal second). 

GL400-1-1 
Sample Period Theoretical 

Battery Life 
Recommended Time Between 

Battery Check 
1 second 88 hours 72 hours 

1 minute 65 days 2 months 

30 minutes 478 days 6 months 

1 hour 536 days 6 months 

1 day 607 days 6 months 

GL400-7-1 
Sample Period Theoretical 

Battery Life 
Recommended Time Between 

Battery Check 
1 second 15 hours 12 hours 

1 minute 12 days 1 week 

30 minutes 234 days 6 months 

1 hour 338 days 6 months 

1 day 591 days 6 months 

Maintenance 



Page 32  Global Water ● (800)876-1172 ● www.globalw.com 

 

5 Troubleshooting 

Comm Failure 

If Global Logger software displays Comm Failure in the Logger Name field, perform the following steps 

• Verify that the communication cable is securely connected to the data logger and to your computer*. 
• Check the battery voltage on the logger**. 
• Make sure that your computer is correctly set up to use your communication channel 1 (COM 1).  Refer 

to the settings below for comparison. 

*  See Hardware Connection, page 18 
**See Battery, page 31 

Chapter 5 
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• Make sure that no other software or device is using COM 1, such as an infrared port or palm synching 
software. 

• If you only have access to COM 2, then an *.ini file must be created.  Open Notepad or a similar basic 
text editor and type the text exactly as it appears in the following screenshot.  Change the directory to 
the Windows folder of your main drive if you are using Windows 95, 98, ME or XP* or to the WINNT 
folder of your main drive if you are using Windows NT or 2000*.  Save the file as global logger.ini. 

*Windows® 95, 98, ME, NT, 2000 & XP are trademarks of the Microsoft Corporation 

Other Issues 
• Call Global Water for tech support: 800-876-1172 or 916-638-3429 (many problems can be solved over 

the phone).  Fax: 916-638-3270 or Email: globalw@globalw.com.  When calling for tech support, 
please have the following information ready; 

 
 1. Model number 
 2. Unit serial number 
 3. P.O. number the equipment was purchased on. 
 4. Our sales number or the invoice number. 
 5. Repair instructions and/or specific problems relating to the product. 
 
 Be prepared to describe the problem you are experiencing including specific details of the application, 
 installation, and any additional pertinent information. 
 
• In the event that the equipment needs to be returned to the factory for any reason, please call to obtain 

an RMA number (Return Material Authorization).  Do not return items without an RMA number dis-
played on the outside of the package. 

 Clean and decontaminate the GL400 sensors if necessary. 

 Include a written statement describing the problems. 

 Send the package with shipping prepaid to our factory address.  Insure your shipment, since Global 
 Water’s warranty does not cover damage incurred during transit. 

Troubleshooting 
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A Appendix A: GL400 Detailed Specifications 

Datalogger 
Inputs 
• Channels:  
 GL400-1-1: 1 Analog, 1 Pulse 
 GL400-7-1: 7 Analog, 1 Pulse 
• Analog: 4-20 mA, pulse contact closure 
• Resolution: 1/4095 (12 bit) 
 
Data Storage 
• Memory Size: 
 GL400-1-1: 25,600 Logs/Channel 
 GL400-7-1: 11,600 Logs/Channel 
• Type: non-volatile Flash 
• Intervals: 1 to 256 seconds, 1 to 256 minutes, 1 to 256 hours, or 1 to 256 days 
• Time Accuracy: 0.0015% 
• Time Format:  Month/Day/Year  Hour/Minute/Second 
 
Communication 
• Speed: 38,400 kbs 
• Data Transfer: 2MB/4 min. 
• Type: RS232C (Serial) 
 
Electrical 
• Battery: 12V Sealed Rechargeable (2A/h) 
• Back-up Battery: 3V Lithium (950 mA/h) 
• Sleep Current: 160µA 
• Wake Current: 100mA + Sensor (4-20 mA) 
• Communication Current: 100mA 
 
Environmental 
• Operating Temperature: -40 to 75°C (-40 to 170°F) 
• Storage Temperature: -50 to 90°C (-60 to 200°F) 
• Humidity: 0 to 95% Non-Condensing (Conformal Protection Coating) 
 
Physical Dimensions - Datalogger 
• Length: 191mm (7.5”) 
• Width: 76mm (3”) 
• Height: 70mm (2.75”) 
• Weight: ~680 g (1.5lbs) 
 

Appendix A 
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 GL400 Detailed Specifications 

Physical Properties - Severe Environment Enclosure (Loaded) 
• Length: 254mm (10”) 
• Width: 191mm (7.5”) 
• Height: 114mm (4.5”) 
• Weight: ~2.268 kg (5lbs) 
• Vent Port: Open or Closed 
• Lockable 
• Entry Port: 7.8mm (.307”) maximum cable diameter 
• Water Resistant 
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B Appendix B: Worksheets 

Calibrating the Bar Graph to Higher or Lower Range 
With some sensors it is either impractical or unfeasible to reach the full-scale or lower scale of its range.  
This will not affect the actual reading of the datalogger but it will cause the bar graph to work incorrectly.   

Here are the equations for finding new limits on the bar graph.  First take the two coordinates that were 
found during calibration*. 
 
 (High EU __________, High Raw __________) and  
 (Low EU  __________, Low Raw __________).  
 
Now calculate the slope using this equation: 
 
 m = (High Raw – Low Raw) / (High EU – Low EU) 
 m = ___________ 
 
Next find the y-intercept: 
 
 b = High Raw - (m * High EU) 
 b = ___________ 
 
Now you can calculate the new “Raw” value for any Engineering Unit.   
 
 New Raw = (m * New EU) + b 
 New Raw = ___________ 
 
Finally, enter these new “Raw” values into your datalogger and verify the readings are correct*. 

*See Analog Channel Calibration, pages 25 – 27 

Appendix B 
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 Worksheets 

Calibrating Level Sensors for Depth to Water Readings 

Note, that to take depth to water readings, the bar graph must be 
calibrated to the full scale of the sensor.  Follow the worksheet 
Calibrating Bar Graph to Higher or Lower Ranges*. 
 
The first step is to find the Total Depth of the sensor.  This is the 
distance from the end of your sensor to your datum.  (Cable lengths 
from the factory are not exact.  You may need to measure for precise 
distances.) 
 
 Total Depth = _____________ 
 
Next, find the maximum Sensor Depth (range of the sensor).  In the 
Calibration** section of the software, you can find this value by 
using the following equation: 
 
 Sensor Depth = | High EU______ - Low EU______ | 
 Sensor Depth = ___________ 
 
Now you can find your new Engineering Units using these steps: 
 
 New Low EU = Total Depth 
 New Low EU = ___________ 
 
 New High EU = Total Depth – Sensor Depth 
 New High EU = __________  
 
Finally, enter these New EU values into your datalogger and verify 
the readings are correct**. 

*  See Appendix B: Worksheets, page 36 
**See Analog Channel Calibration, pages 25 – 27 
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C Appendix C: Terminal Programming 

Communication Commands for Windows Datalogger 
The following is a chart of commands that can be sent to the Windows Datalogger through a terminal 
program. 

Command Description 

D Set Date 

T Set Time 

? Get number of data points 

h Get first historical data point 

a Get historical data point again 

X Abort 

i Get next historical data point (increment) 

E Erase 

r Get real time data point 

! Set description 

1 Get description 

@ Set Units 

2 Get Units 

# Set Raw Scale 

3 Get Raw Scale 

$ Set Engineering Unit Scale (EU) 

4 Get Engineering Unit Scale (EU) 

N Set Name 

n Get Name 

S Set Sample interval 

s Get Sample interval 

Appendix C 
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D Appendix D: Recharging the Battery 

Please use the following cautions while charging the battery: 
• Do not seal the enclosure while charging the battery. 
• Do not leave the charger connected to the battery for more than 72 hours. 

Recharging the Battery 

Disconnect the datalogger’s red and blue 
spade lugs from the battery.  Ensure that 
the battery charger is not plugged in.   

Disconnect spade 
lugs from battery 

Connect the charger’s blue spade lug to the battery’s 
black terminal.  Connect the charger’s red spade lug 
to the battery’s red terminal.  Plug the charger into 
the wall. 

red (+) terminal 

black (-) terminal 

charger 

step 1: connect blue spade 
lug to black terminal 

step 2: connect red 
spade lug to red terminal 
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The battery should charge a minimum of 12 hours.  After charging the battery, unplug the charger and 
check the battery voltage using a multimeter.   If the battery voltage has increased but not reached 12V it 
may need to be left on the charger longer.  If the battery voltage has not changed, replace the battery.  Oth-
erwise disconnect the charger from the battery and reconnect the datalogger to the battery. 

Appendix D 
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 External Power Sources 

E Appendix E: External Power Sources 

The EXT terminals of the datalogger can be used to provide an external power source to the logger.  The 
external power source however, must be chosen with care.  The source voltage cannot be greater than 30 
VDC and must fall within the input voltage range of each sensor attached to the datalogger. 

The battery that was included with the GL400 will operate in parallel with the external.  Thus, a supplemen-
tal 12V source, such as a solar panel, may be added to increase the battery life.  If this method is chosen the 
external source must be diode protected from the battery voltage.  The battery does not need to be protected, 
this allows the battery to remain charged while the external source has power.  CAUTION:  The enclosure 
must be vented or gasses could build up inside the case causing a rupture. 

Alternatively, the 12V battery can be removed from the enclosure and the datalogger can be connected ex-
clusively to the external power source.  This method does not provide a battery backup for the logger to 
continue logging, however there is a battery backup to retain the data already collected.  

To connect an external power source to the datalogger, thread the power source cable through an enclosure 
strain relief and attach wires to EXT terminals.  Before inserting wires into terminals you may need to 
loosen terminal screws.  Insert the black wire into either of the – (ground) terminals and tighten until secure.  
Insert the red wire into the + (power) terminal and tighten until secure. 

insert black 
to negative 

insert red 
to positive 


